Navigating Prison Policies and Exhaustion
A guide for people incarcerated in Pennsylvania

Black and Pink
Northeastern University School of Law

March 2017

Please note there may have been changes in state law, regulations, prison policies, or court
cases since the completion of this guide

Table of Contents
Accessing the Court
Filing a Grievance
Disciplinary Process
Solitary Confinement
Using and Understanding PREA
The PREA Reporting Process
Your Rights as a Trans Person
Using this Guide

2
4
10
21
25
27
34
37

Black and Pink

614 Columbia Road
Dorchester, MA 02125
1

Accessing the Court
You must finish all the steps of the prison’s grievance or disciplinary process in
order to bring a lawsuit to court.
This is called “exhaustion of administrative remedies.”
For state and federal courts, you must finish all the steps to bring a lawsuit.
You must finish these steps by the prison’s deadlines. You also have to follow all of
the prison’s rules about the grievance and disciplinary processes, many of which
will be explained in this guide.
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Accessing the Court
If You Cannot Complete All the Steps
There are certain times when the court might let you bring a lawsuit anyway.
These are very rare exceptions, so you should do your best to complete all the
steps.
If your situation fits any of these cases, then list the name and citation of the case
when you file your lawsuit.
➔ If you never received a response from
the prison at any step in the process.
○ Small v. Camden County, 728
F.3d 265, 273 (3rd Cir. 2013).
○ Gellock v. Prison Health Servs.,
No. 07-8 Erie, 2009 U.S. Dist.
LEXIS 131176, at *20 (W.D.
Pa. June 8, 2009).

➔ If prison staff gives you wrong
information about the grievance
steps.
○ Brown v. Croak, 312 F.3d 109,
113 (3rd Cir. 2002).

➔ If you move prisons and cannot get
the grievance forms from your last
prison.
○ Hankins v. Pennsylvania, No.
09-182 Erie, 2011 WL
6739289, at *12 (W.D. Pa.
Nov. 30, 2011).

➔ If you sue for more than one issue,
the court might let you sue on the
issues you've completed the steps
for. But, the court won't let you sue
on the issues you haven’t completed
all the steps for.
○ Jones v. Bock, 549 U.S. 199,
206 (2007).

➔ If you couldn’t file all of your
grievances because you were on
grievance restriction.
○ Bussinger v. Dyne, 76 A.3d
137, 141 (Pa. Commw. Ct.
2013).
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Filing a Grievance
The prison grievance policy is DC-ADM 804.
The title of this policy is “Inmate Grievance System.”
When to File a Grievance
➔ The grievance process applies to a
lot of concerns you may face in
prison.

Do NOT File a Grievance if your
concern is about:
● An emergency
● Sexual assault (see page 25)
You do file a grievance for sexual
harassment.
● Disciplinary punishment
Before You File
➔ You do not have to try to fix the
problem informally, but the prison
encourages it.

The prison does not want you to fix
the problem informally if the problem
is sexual assault or physical assault.
It is illegal for the prison to punish

you, retaliate against you, or hurt you
for filing a grievance.
Things to Know
➔ You can withdraw your grievance at
any time.
Use: Grievance Withdrawal Form
○ Include:
● The grievance number
● Your reason for stopping
the grievance process
● Your signature
○ Give the form to the Facility
Grievance Coordinator.
➔ If you cannot file the papers on time,
then the prison will consider giving
you more time. But this depends on
your reason for being late.
○ There is no guarantee that the
prison will give you more time.
➔ Make copies of all your paperwork
and the dates that you filed them!
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Filing a Grievance
Timeline of the Grievance Process
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Filing a Grievance
Step One: Filing the Initial Grievance
When, What, and How to File
File within 15 days of the event.
Use Form DC-804, Part 1
○ Include:
✔ Your commitment name
✔ Date, time, location, and
people involved

Things to Remember
➔ If you need more space, you can
include one extra 8 ½ by 11 sheet of
paper that is handwritten or typed.
➔ Make copies of everything before you
turn it in. Make copies of all the
evidence too.
➔ Turn it into the box labeled
“Grievances” which should be in the
housing unit or the dining hall.

✔ Which policies, regulations,
and laws the prison has
broken
✔ What changes you are
looking for and other things
you would like to receive
● Even those things that
the prison can’t give but
a court might be able to
give (for example,
money)
✔ All the issues from the
event that you want to address
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Filing a Grievance
Step One: Response from the Facility Grievance Coordinator
Response Time
➔ The prison is required to give you a
response within 15 days of entering
the grievance into their system.
➔ The prison may take 10 extra days if
the investigation of the event is not
done.
○ The prison has to notify you in
writing if they will take this
extra time to respond to your
grievance.

Response Content
➔ The response must include:
✔ A finding
● “Uphold Inmate”
● “Grievance Denied”
● “Uphold in Part/Deny
in Part”

✔ Any actions that the prison has
taken or any actions that the prison
recommends to solve every issue in your
grievance

No Response

If you do not get a response from the
prison, you cannot appeal within the
prison system by proceeding to Step
2.
➔ You can bring a lawsuit to court
about your concern if you do not get
a response from the prison.

✔ The coordinator’s
reasoning for their finding
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Filing a Grievance
Step Two: Appeal to the Facility Manager
You can only file an appeal once you have received a response from Step One.

How to Appeal to the Facility Manager
File within 15 days of the response to
Step 1.
Use Form: Inmate Appeal to the Facility
Manager
➔ You can also use 8 ½ by 11 writing
paper.
○ If you use writing paper
instead of the form, write
“Appeal” and the grievance
number at the top of the page.
➔ The appeal can be 2 one-sided
pages at most.
➔ The appeal can be handwritten or
typed.

Content of the Appeal
➔ Only appeal issues from what you
discussed in Step 1.
○ If there are any new issues,
start a new grievance starting
at Step 1. New issues might be
retaliation for filing your
grievance or a new event.
➔ Make copies of everything before you
turn it in. Make copies of all the
evidence too.

Response from the Facility Manager
➔ The prison must give you a response
within 15 days of receiving the
appeal.
➔ The response must include:
✔ A finding
● “Uphold Inmate”
● “Grievance Denied”
● “Uphold in Part/Deny in
Part”
✔ The manager’s
reasoning for their finding
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Filing a Grievance
Step Three: Appeal to Final Review
You can only file an appeal after you have gotten a response from Step Two.
How to Appeal to Final Review
File within 15 days of the response to Step
2.

Use Form: Inmate Appeal to Final
Review
➔ You can also write out or type the
appeal on 8 ½ by 11 writing paper.
➔ Include:
✔ Copy of Step 1 from page 6 and
Response from page 7
✔ Copy of Step 2 and Response
from page 8
➔ Make copies of everything before you
file an appeal.
➔ Send to the address:

Response from the Chief Secretary
➔ The office must respond to the
appeal within 30 days of receiving
the appeal. If not, they must tell you
of an extension or refer the appeal to
another office.

➔ The response must include:
✔ A finding

● “Uphold Inmate”
● “Grievance Denied”
● “Uphold in Part/Deny in
Part”
✔ The office’s reasoning for

their finding.
➔ The office can also send the
grievance back to the prison for
further review

Chief Secretary’s Office of Inmate Grievances and Appeals,
Department of Corrections
1920 Technology Parkway
Mechanicsburg, PA 17050

9

Disciplinary Process
The prison disciplinary policy is DC-ADM 801.
The title of this policy is “Inmate Discipline.”
Your Rights When Facing Disciplinary
Forms the Prison Must Give You
Inmate Request for Representation and
Charges
➔ 37 Pa. Code 93.10(b) says you have
a right to:
✔ Written notice of the charges
✔ A hearing from a neutral
(someone not involved in the
event) examiner or a chance to
be heard in an informal
process
✔ The chance to tell your story
and present evidence
✔ Help from another prisoner or
staff member at your hearing if
you cannot collect and present
evidence yourself
➔ A Shift Commander must give their
approval if you are sent to
confinement before your hearing.
It is easier to be found guilty by the
prison than in a criminal trial in
court. The prison does not have to
say you did it “beyond a reasonable
doubt” in order to punish you.

Witnesses Form (DC-141 Part 2A)
○ Complete and submit to the
block office by 9 am the day
after you receive the notice
Hearing Supplement, Inmate Version,
and Witness Statement Form (DC-141
2C)
○ Complete and bring to your
hearing

If you have a mental illness or
intellectual disability
➔ The prison is required to set up an
interview with a mental health
professional before your hearing.
➔ The examiner at the hearing has to
look at the professional’s advice.
Then the examiner can make a
decision.
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Disciplinary Process
Types of Misconduct
Class 1
➔Examples of Class 1 Misconduct
○
○
○
○
○

Assault
Murder
Rape
Threatening Another Person
Possession or Use of a
Dangerous or Controlled
Substance
○ Damaging Property

➔Possible Punishments
○ Solitary confinement for no
more than 90 days
○ Cell restriction for no more
than 30 days
○ Removal from job
○ Loss of privileges for no more
than 180 days
○ Reprimand, warning, or
counseling
○ Limits on commissary
privileges
○ Taking away outside program
codes

Class 2
➔Examples of Class 2 Misconduct
○ Body punching or horseplay
○ Unexcused absences from
work, school, or other
mandatory programs
○ Smoking where prohibited
○ Kissing or inappropriate
physical contact

➔Possible Punishments
○ You cannot be placed in
solitary confinement because
of a Class 2 misconduct.
○ Other punishments for Class 2
misconducts are the same as
for Class 1 misconducts.
Prisons are not supposed to
discipline you for attempting suicide
or for hurting yourself. You are
entitled to treatment.
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Disciplinary Process
Steps of the Disciplinary Process
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Disciplinary Process
Step One: Informal Resolution
Informal Resolution Hearing
➔ Informal resolution is possible for
prisoners charged with Class 2
charges or some Class 1 charges.
○ The Shift Commander chooses
if there should be informal
resolution or a formal hearing.
○ You can refuse an informal
resolution, but there will then
be formal hearing about the
charge.
➔ An informal resolution hearing must
be within 7 working days of the
notice of the charges.
➔ The hearing is a meeting with the
Unit Manager and at least 1 other
member of the Unit Management
Team.
○ The prison advises that the
staff member who reported the
misconduct attend the
informal resolution hearing.
But, the staff member does
not have to go.
➔ You have a right to tell your story
about what happened.

Possible Consequences
➔ Punishment following an informal
resolution hearing may include:
○ A reprimand and warning
○ No more than 14 days of cell
restriction
○ No more than 14 days lost
special privileges
○ 14 days loss of commissary
○ Assignment of additional,
unpaid work duties
○ Loss of job
➔ The prison must provide you with a
form indicating your punishment at
the end of the hearing.

Informal Resolution Appeal
➔ The only way you can appeal an
informal resolution finding is to say
that the “sanction is
disproportionate to the offense.”
○ The punishment is too harsh
for what you were found guilty
of.
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Disciplinary Process
Step One: Formal Misconduct Process
Formal Misconduct Hearing
➔ A formal misconduct hearing must
be between 24 hours and 7 working
days of notice of the charges.
➔ A formal misconduct hearing will
happen if you reject your right to
informal resolution. Some Class 1
misconducts cannot get informal
resolution.

What Will the Hearing Look Like
➔ The prison must use an official
translator or interpreter for hearings.
➔ The Hearing Examiner is the only
person who decides if you are guilty.
○ A CO will be in the room.
○ Another person may also be in
the room to record the hearing.
Recording may also be done
by the CO.
➔ The hearing may happen in the
Hearing Room. The Hearing Examiner
can choose where to have the
hearing.
➔ You have a right to attend the
misconduct hearing. But you can
refuse to go.
○ The Hearing Examiner may
remove you if they decide your
actions are disruptive or they
consider you to be not
following instructions.
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Disciplinary Process
Step One: Formal Misconduct Process
Process of the Misconduct Hearing
➔ The Hearing Examiner must ask you
for your plea on each misconduct you
are charged with.
➔ You have a right to present your story
about what happened, either by
speaking or in writing.
➔ The Hearing Examiner may approve
up to three people who witnessed
the event to attend the hearing.

Prison Response
➔ The Hearing Examiner should make a
decision within 7 calendar days of
your hearing.
➔ You will then be called in front of the
Hearing Examiner to hear the
decision.
➔ The decision will also be given to you
in writing.
○ If you are found guilty, the
response should have the facts
used to find you guilty and why
they decided that way.
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Disciplinary Process
Step Two: Appeal to the Program Review Committee
You can only file an appeal if you are found guilty of the misconduct
How to Appeal to the Program Review
Committee
➔ You must file an appeal within
15 calendar days of your
hearing.
Use Form: Misconduct Hearing
Appeal (DC-141, Part 2E)
○ Include:
● A short review of the
facts that are relevant to
your appeal
● Your reason for
appealing
➔ You may ask for help in filling out the
appeal form from:
○ A prison staff member
○ A certified peer specialist
○ A prisoner in the same
population status

Reasons You Can Use When Appealing
1. “the procedures employed were
contrary to law, Department
directives, or regulations”
○ The prison did not follow the
rules in the process of
charging you or in your
hearing.
2. “the punishment is disproportionate
to the offense”
○ The punishment you got is too
harsh for what you were found
guilty of.
3. “the findings of fact were insufficient
to support the decision”
○ There were not enough facts to
prove you are guilty.
➔ If you had a formal misconduct
hearing, you can appeal a decision
based on one, two, or all three of
these reasons.
➔ If you had an informal resolution, you
can only appeal based on reason 2.
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Disciplinary Process
Step Two: Response from the Program Review Committee
The committee has to give you a
response within 7 working days of
getting your appeal.

Possible Responses You May Get
➔ Rejected because the appeal did not
follow the standards.
○ You didn’t fill out the form
correctly or follow all the rules
when appealing.
➔ No changes to the original decision
○ Your first hearing got it right,
and the outcome stays the
same.
➔ Modification to the punishment but
there is no change to the guilty
finding.
○ Your first hearing was right
about the outcome, but the
punishment was too harsh.
➔ Discharge of the guilty finding and…
○ Remand for a rehearing
● The hearing you got
wasn’t right, so there
needs to be a new
hearing.
○ Prohibit any recharge
● You are not guilty, and
the charges are
dropped.
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Disciplinary Process
Step Three: Appeal to the Facility Manager
How to Appeal to the Facility Manager
➔ You must file an appeal within 7
calendar days of getting the
response from the Program Review
Committee.
Use Form: Misconduct Hearing Appeal
(DC-141, Part 2E)
○ This is the same form as
used in Step 2.

Response from the Facility Manager
➔ The Facility Manager has to send you
a response within 7 working days of
getting your appeal. Days when the
Facility Manager is not at the prison
are not part of those 7 days.
➔ Responses may say the same thing
as described in the possible
responses from Step 2, described on
page 17.

➔ Include:
○ Your reason for
appeal
● These reasons
are described
on page 16.
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Disciplinary Process
Step Four: Appeal to the Chief Hearing Examiner
How to Appeal to the Chief Hearing
Examiner
➔ You must file an appeal within 7
calendar days of receiving the
response from the Facility
Manager after completing Step 3.
Use Form: Misconduct Hearing
Appeal (DC-141, Part 2E)
○ This is the same form as
used in Step 2 and Step 3.
Mail the Appeal to the Chief Hearing Examiner

The Chief Hearing Examiner’s Office 1920
Technology Parkway Mechanicsburg, PA
17050

What to Include:
➔ A brief review of the relevant facts
➔ Your reason for appealing, from page
16
➔ Copies of:
○ Misconduct Report received
prior to the hearing
○ Inmate Request for
Representation and Witnesses
Form (DC-141 Part 2A)
○ Hearing Supplement, Inmate
Version, and Witness
Statement Form (DC-141 2C)
○ Hearing Examiner’s report
received after Step 1
○ Misconduct Hearing Appeal
(DC-141 2E) from Step 2
○ Response from the Program
Review Committee
○ Misconduct Hearing Appeal
(DC-141 2E) from Step 3
○ Response from the Facility
Manager
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Disciplinary Process
Step Four: Response from the Chief Hearing Examiner
The Chief Hearing Examiner must

review and respond to the appeal
within 7 working days of receiving
all of the documents.
○ If the decision from Steps 1-3
is upheld (meaning that the
decision is not changed), then
you are required to receive a
response in writing.
○ If the decision from Steps 1-3
are changed, then the Chief
Hearing Examiner will send you
a letter about the change.
● This letter may take
more time to receive,
because it must be
approved by the
Regional Deputy
Secretary.
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Solitary Confinement
The Restrictive Housing Unit (“RHU”) limits out-of-cell time and what prisoners can
do compared to the general population. There are two types of RHU: Administrative
Custody (“AC”) and Disciplinary Custody (“DC”). Protective Custody is a type of AC.
Common Ways to be Placed in AC if the
prison considers you to be dangerous

➔ If you’re moved to AC after finishing
time in DC
➔ If you’re dangerous to yourself or
others
➔ If you’re placed in Protective Custody
because General Population isn’t
safe for you based on your request or
the prison’s assessment
➔ If you’re being investigated for
violating rules
➔ If you’re being transferred into a new
facility
➔ If you request self-confinement

Ways to be Released from AC

➔ You have the right to a hearing with
the Program Review Committee a
day after being put in AC.
➔ If the Program Review Committee
keeps you in AC, you have two days
to challenge the decision in writing
to the facility manager.
➔ You can also challenge the Program
Review Committee’s decision within
7 days by writing to the Office of the
Chief Hearing Examiner. The address
is:

The Chief Hearing Examiner’s Office,
Office of Chief Counsel, 1920
Technology Parkway,
Mechanicsburg, PA 1705

21

Solitary Confinement
Disciplinary Custody (“DC”)
Common Ways to be Placed in DC

➔ Misconducts like:
○ Disobeying orders
○ Fighting
○ Assault
○ Threatening a prisoner or staff
○ Sexual acts with others
○ Indecent exposure
For DC, there are no set sentence time limits.
Prison staff can decide how long to put you in DC.
Length of time in DC can be different for the same
misconduct.

Ways to be Released from DC

➔ When you’re put in DC for Class I Charges
1-14, you must serve the entire time of
your sentence. For example, if given 30
days in DC for fighting, you have to serve
30 days.
➔ The Facility Manager or Program Review
Committee can move you to AC after you
serve at least half your sentence in DC. For
example, if you’re sentenced to DC for 20
days, the Facility Manager can move you
to AC after 10 days.
➔ If you’re sentenced to more than a year in
DC, you can get out of DC early with good
behavior. The Facility Manager and
Program Review Committee decide who
gets released from DC for good behavior.

22

Solitary Confinement
Conditions of Solitary Confinement
Cell Expectations
➔ 23-hours of in-cell time
every day
➔ Maximum of 4 visits
every month
➔ Maximum of 4 phone
calls every month
➔ Lights on all day in cell

Consider Common Longterm Effects
➔ Prisoners in RHU often
struggle with maintaining
mental health.
➔ Other common side
effects:
○ Hallucinations
○ Panic attacks
○ Obsessive thoughts
○ Paranoia
○ Difficulty focusing
➔ BUT, not everyone goes through these
things.
➔ If you are experiencing these side effects,
you are not alone. You can ask for mental
health care. Request a Survival in Solitary
manual here:

American Friends Service Committee,
1501 Cherry St. Philadelphia, PA 19102

Prisoners with SMI or ID
This is specific to prisoners classified as Stability
Code C and D. SMI is serious mental illness. ID is
intellectual disability.
Even in RHU, prisoners with SMI/ID are
guaranteed:
➔ At least 23 hours of out-of-cell time every
week
➔ Access to a secure residential treatment
unit
➔ Individual recovery plan to cope with
SMI/ID in prison
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Solitary Confinement
Know Your Rights

For AC, you are entitled to:
àA copy of DC-141, Part 1, Misconduct
Report explaining why you were put in AC.
This should be given to you within 24-hours
of being put in AC
àA hearing with the Program Review
Committee if you’re being transferred from
DC
àConsideration for other safety options if
being placed in AC for protection
àAccess to programs if in AC for
involuntary protection
àBe released from protective custody
before or within 30 days, usually

For DC, you are entitled to:
àA copy of DC-141, Part 1, Misconduct Report on the
same day it’s written
àReview by the Facility Manager if placed in
confinement before your hearing
àNotice of the verdict of your formal misconduct hearing
àImmunity from DC for attempting to hurt yourself

Know that Black and Pink considers solitary confinement in any form to
be inhumane. We are working with prisoners and outside allies to abolish
solitary confinement, no matter what name it gets called.
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Prison Rape Elimination Act
Using and Understanding PREA
The Basics
➔ PREA is the Prison Rape Elimination
Act. PREA seeks to prevent rape in
prisons.
➔ PREA is a federal law.
Each state can choose to
comply with PREA.
✔ Pennsylvania has chosen
to comply with PREA. This
means that there are certain
standards each prison must follow.

àConsensual Sex
You can be punished for consensual

sex. This includes any contact between
the mouth or genitals and any part of
the body.

Important Definitions
➔ Sexual Abuse
Sexual abuse refers to contact between the
genitals and any other part of the body.
The contact must be intentional. The
contact may be direct or through
clothing. The contact must be done
without consent.
➔ Sexual Harassment
Repeated and unwelcome sexual
advances; requests for sexual favors;
insulting gestures or comments by one
person towards another.
Repeated means two or more incidents.
This may be two or more single incidents
to multiple survivors by a single person.
➔ Retaliation
An act of revenge against a person in
response to a PREA report. The act may
be in response to making a PREA report
or cooperating with an investigation. The
acts may be open and obvious or they
may be in secret.
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Prison Rape Elimination Act
How PREA Might Affect You
Cross-Gender Searches
➔ Prison staff generally may not
conduct cross-gender searches.
PREA makes an exception when
extremely necessary.

Education
➔ The prison must give you training on
PREA when you enter the prison. The
prison must help people who are
blind, deaf, hard of hearing, or with
limited English skills to understand
the training.
➔ Training must explain:
○ Department
procedure on
responding to
reports
○ Instructions on
how to report; and
○ What to do if you
have been sexually
harassed, abused,
or retaliated
against.

Vulnerability Screenings
➔ Prisons must assess a prisoner’s risk
for being harmed. The prison
considers both if a person is likely to
hurt someone else or if a person is
likely to be harmed.
○ Screening takes place on
intake. Screening happens
again after making a PREA
report.
➔ Prisons use these screenings to
assign placement of prisoners.
○ You cannot be placed in a
housing unit based solely on
identifying as LGBTQI.
➔ Prisons consider the following:
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The PREA Reporting Process
Step One: Making a PREA Report
What to Report
➔ You can file a PREA report about
sexual assault or sexual harassment
committed by prison staff. You can
report sexual assault committed by
prisoners as well. You can also file a
PREA report about retaliation for
filing a report.
○ You can report that the
prison staff allowed
someone to sexually
abuse or harass you.
➔ You should include as many details
as possible. You should include the
following:
✔ Description of the events
✔ Names of all parties and
witnesses
✔ Date, time, & place
➔ There is no time limit to file a PREA
report. If you plan on bringing a
claim to court there are time limits
that vary with the claim you bring. If
you have been sexually assaulted,
you can preserve evidence by getting
medical attention before showering,
using the bathroom, or brushing your
teeth.

Where to Report
➔ You have the right to report
immediately and privately. A report
can be made to any staff member in
the facility. That includes Corrections
Officers, Counselors, Medical Staff,
and others.
➔ A report can be verbal or written. Use
the Inmate Request to Staff Member
form (DC-135A) for a written report.
You can also send a written sexual
abuse report to the PREA
Coordinator:

BCI/PREA Coordinator
1800 Elmerton Ave.
Harrisburg, PA 17110
PREA reports for sexual abuse and staff sexual harassment may not be filed
through the grievance procedure.
You cannot make a PREA report about
prisoner-on-prisoner sexual harassment.
You must use the grievance procedure (on
page 4).
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The PREA Reporting Process
Step Two: Guaranteed Protections
General Expectations
➔ The prison must separate you and
the person who harmed you right
away. For a report of sexual abuse,
the separation may be a housing
change within the unit or a unit
transfer.
○ The prison may transfer either
you or the person who harmed
you. The prison may put you in
administrative custody. The
prison can do this if there are
no alternative placements
available.
○ You may also request to be
placed in administrative
custody after making a report.
➔ The prison must secure the crime
scene. They will ensure that no one
destroys evidence.

Retaliation
➔ Retaliation by staff and prisoners for
reporting is not allowed. The prison
must provide emotional support
services. The prison may also allow a
housing change if necessary. The
prison works with the Deputy
Superintendent for Centralized
Services to monitor retaliation.
➔ However, retaliation is a reality for
many prisoners. Reports can be
made anonymously and through
third parties. You cannot be forced
to continue participating in the
reporting process.

28

The PREA Reporting Process
Step Two: Guaranteed Protections
Medical Care
➔ The prison must give you medical
treatment free of cost. The prison
must provide treatment even if you
choose not to participate in the
investigation.
➔ You must be evaluated by the
prison’s medical staff immediately if
the report involved physical contact.
○ You have the right to refuse a
medical exam. You will have to
sign a Release from
Responsibility form (DC-462)
for the prison.
➔ The prison must provide you with
timely emergency medical treatment
free of charge. The medical and
mental health staff determine what
treatment will be given.

If sexual abuse occurred within
the past 96 hours
➔ The prison must transport
you to an outside hospital. A rape kit
will be done.
Within 96 hours: photos may not be
taken of the survivor. Photos may be
taken of the abuser.

➔ Antivirals may be given if there is
risk of HIV. The physician will run an
STI test. You may refuse treatment by
signing a release form (DC-462).
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The PREA Reporting Process
Step Three: Process of Evaluation
Investigation
➔ The prison interview
you, the person who
harmed you, and any
witnesses.
○ The prison may not discredit
you or a witness because of
your status as a prisoner.
➔ The prison may decide to involve
outside prosecutors in the
investigation.
○ The prison must do so if it
believes the evidence supports
criminal charges.

Determination
➔ A report will be categorized into one
of three types:
-Substantiated- evidence shows the
incident did happen.
Unsubstantiated*- not enough
evidence to decide.
Unfounded- evidence shows the
incident did not happen.

A report is in good faith if the
incident could reasonably have
happened. The prison may
discipline a prisoner for reporting
in “bad faith.” Unsubstantiated
reports may not be in bad faith.
*Just because the prison says the
assault is unsubstantiated, does not
mean you did not experience sexual
assault. If you need resources as a
survivor of sexual violence while in
prison, you can contact Just
Detention International:

Just Detention International
3325 Wilshire Blvd, Suite 340
Los Angeles, CA 90010
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The PREA Reporting Process
Step Three: Process of Evaluation
The prison has time limits for completing its investigation. The timeline
below gives the number of days the prison has to complete each step.
The prison may complete the investigation in less time if it is possible.

24 Hours--Preliminary
Investigation

5 Days-- Notification to
Prisoner

15 Days-- Review of
Investigation

5 Days-- Assignment to
Investigator

30-60 Days-Investigation (30 days if
sexual abuse, 60 days if
sexual harassment)
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The PREA Reporting Process
Steps Four-Five: Response and Bringing a Claim to Court
Response
➔ The prison must inform you whenever
the abuser has been criminally
charged or convicted.
➔ You must be informed of the result
of your report within 90 days of the
filing of your report.
➔ If the report is substantiated and
appears to be criminal, the prison
must refer the investigation to
outside prosecutors.

Bringing a Claim to Court
Right of Action
PREA does not have a right of action. This
means that you cannot bring a claim to
court based on a PREA violation alone. You
must bring your claim under a different right
of action.
○ For example, many prisoners have
brought 8th Amendment violation
claims. The 8th Amendment
prohibits cruel and unusual
punishment.
➔ Follow the grievance process when you
can. Claims regarding sexual
harassment by prisoners must be filed
through the grievance procedure (on
page 4).
➔ Weigh the pros and cons of going to
court:
○ Talk to outside groups to see if there is
a chance you can get help with your
case. Keep as much evidence of the
events relating to your claim as you
can.
○ Courts have given prisons a low
standard to excuse their actions, but
prisoners have still succeeded in
certain cases.
See Delandro v. Cnty of Allegheny
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The PREA Reporting Process
Resources for Survivors
Pennsylvania Coalition Against Rape (PCAR)
➔ PCAR provides help to survivors of
sexual assault. PCAR also provides
general information on sexual violence.
125 North Enola Drive
Enola, PA 17025
Hearts on a Wire Collective
➔ Hearts on a Wire is Pennsylvania
organization that supports trans and
gender variant prisoners. Hearts on a
Wire works for justice for the
transgender community.
1315 Spruce St
Philadelphia, PA 19106
Transgender Law Center (TLC)
➔ TLC responds to letters from LGBTQ
people in prison. TLC can help you
handle incidents of sexual abuse,
sexual harassment, and retaliation.
PO Box 70976, Oakland, CA 94612

33

Your Rights as a Trans Person
Access to Public Information
Get the information you want!
➔ Under Pennsylvania’s Right-to-Know
Law, you can get access to public
information.
○ Ask for health care policies!
○ Ask for what privacy policies
are available for trans people!
○ Are you wondering where to
send your request to get info
on trans-specific rights?

Send your info request to the
Department’s Agency Open Records
Officer at:
Andrew J. Filkosky, Agency Open Records
Officer
Department of Corrections
Right-to-Know Law Office
1920 Technology Parkway Mechanicsburg,
PA 17050
Phone: (717) 728-7763
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Your Rights as a Trans Person
Commissary Items
What can you purchase and own if you
are a trans man in a female facility?

What can you purchase and own if you
are a trans female in a male facility?

➔ Transgender male prisoners within a
female facility may purchase and
own the following:
○ BH mens briefs (any size from
small to 7X)
○ Hanes mens briefs (any size
from small to 3XL)
○ Athletic supporter (any size
from small to XL)

➔ Transgender female prisoners within
a male facility may purchase and
own the following:
○ Plastic self hinge barrette 3pk
○ Claw clip, assorted colors 8pk
○ Shower cap, disposable
○ Goody foam rollers, yellow
12pk
○ Mascara, black .27 oz
○ Eye pencil duo black, 3” 2pk
○ Lipstick, brown shade, red
shade, 13 oz.
○ Eyeshadow trio
○ Womens briefs white 3PK (size
5 to 14)
○ BH women’s briefs 3pk (size
small to 7X)
○ Champion bra (size small to
extra large)
○ Tortoise side comb 2pk
○ BH Headscarf
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Your Rights as a Trans Person
Know Your Rights
Right to Privacy
You must be allowed to shower
separately and privately from other
prisoners.

Housing

➔ Unfortunately, how you identify
yourself is not enough for you to be
housed where you want or deserve.
➔ You need proof that it would be
unhealthy or dangerous for you not
to be placed in the facility you want.
➔ In general, the Department of
Corrections chooses where to house
trans people.
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Using this Guide
We hope that this guide can
help you.
Please remember that the
suggestions in this guide are
optional. You should not do
anything you do not feel
comfortable with.
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